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Network Rendering
Bigger, better, faster, more. If that's your mantra, you probably have a number of computers on your own
network. Surely if one computer is good, more must be better. With network rendering, that's never been
more true.
Network rendering allows you to designate a specific computer to render the entire output file,
(nondistributed rendering) or you can distribute a single rendering job among several computers.
Both distributed and nondistributed rendering jobs can be queued to be performed as computing
resources become available so you can render multiple projects or render the same project in multiple
formats.
Rendering using a computer other than your main editing computer allows you to continue working
without waiting for the render job to complete.

Is network rendering for you?

Maybe. There are many variables involved with network rendering: your computer speed, network speed
and project complexity all have an impact on network rendering performance.

If you have fast computers on a fast network, you may see improved rendering performance. If you have
slow computers on a slow network, you may see no benefit.
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Setting up Your Computers

The computer that initiates and manages a network render is considered the owner of the job. Each
networked computer that you use for rendering is called a renderer. The computer that reassembles
rendered segments in a distributed rendering job is called the stitch host. The computer that is designated
to perform a nondistributed network render job is called the render host.

To use network rendering effectively, we recommend the following:

* 256 MB RAM in each renderer.

+ 100 Mbps switched Ethernet network for basic projects (DV output with minimal compositing).

* Gigabit Ethernet network for more complex projects (uncompressed output and/or significant
compositing).

* Your media files and output file must be in shared folders, preferably on a dedicated file server. All
renderers must have permission to read, write, create, and delete files in the shared folders.

Before network rendering begins, a copy of your project will be saved in the shared output folder for
use by the renderers. This version will have all media paths remapped based on the Network Render
Service file mappings (see “Set file mappings” on page 7 for more information).

Setting up a renderer

1. Install Vegas software on the computer you want to use as render client.

You can install Vegas software on up to three computers (your main editing computer and up to
two renderers). You must use the same information (serial number and registration information)
on all computers.

If you need to purchase additional licenses, please contact our Customer Service department.
Trial installations of Vegas software cannot be used for network rendering.

Certain file formats, such as MPEG-2, AC-3, and MP3, are licensed per computer and cannot be
used on render-only clients. Additionally, MPEG-2 can be used for the final output format, but
not for rendered segments in distributed rendering.

@ If you want to use network rendering with these formats and have a multiprocessor computer or
a computer with a processor that supports Hyper-Threading technology, you can run multiple
instances of the render service on that computer.

2. Start the Vegas Network Render Service application (VegSrv50.exe). The service must be running
and you must be logged into the computer before you can use it for rendering.

3. If necessary, you can change the TCP port the render service uses to communicate with other
renderers. In most cases, the following steps are not required:

a. Exit the Vegas Network Render Service application if it is running.

b. Open the NetRenderService.config file in a text editor. This file is located in the Vegas 5.0
installation folder.

c. Edit the <channel ref="tcp" port="53704" /> tag in the file to reflect the port you want to
use.

d. Save the file.
e. Restart the Vegas Network Render Service application.
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Troubleshooting initialization problems
If you receive an error message that indicates the Network Render Service cannot start when you
start the application, you may need to resolve DNS suffixes on your computer.

6 Failed to initialize network render service:

The requested name is valid and was found in the database, but it does
not have the correct associated data being resolved for,

The application must exit,

1. Open a DOS window:
a. From the Start menu, choose Run to display the Run dialog.
b. In the Open box, type CMD.
c. Click oK. A DOS window is displayed.

2. Type ipconfig at the command prompt.

Your Windows IP Configuration information is displayed. Note the Connection-specific DNS suffix
setting.
3. Update your computer's DNS suffix:
a. Right-click My Computer on your desktop and choose Properties from the shortcut menu (or
press the Windows key + Pause) to open the System Properties dialog.

b. Select the Computer Name tab.

c. Click the change button to display the Computer Name Changes dialog.

d. Click the More button to display the DNS Suffix and NetBIOS Computer Name dialog.

e. In the Primary DNS suffix of this computer box, type the DNS suffix you recorded in step 2.
4. Click oK to close all dialogs and restart your computer.
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Adding or removing renderers for your editing computer

The list of computers on the Renderers tab of the Vegas Network Render Service application
determines which renderers you'll be able to use from the editing computer.

You add renderers to the Vegas Network Render Service application on the editing computer only. No
changes need to be made on the renderer.

Adding a renderer

1. Start the Vegas Network Render Service application (VegSrv50.exe) on the computer you will use
to initiate network rendering.

If you do not start the service before starting a rendering job, it will start automatically, but it will

not be visible. Right-click the == - icon in the system tray and choose Show from the menu to
display the window.

2. Select the Renderers tab. This tab allows you to edit the list of computers running the render
service.

@A computer will be available only if you have logged on to Windows and the Vegas Network
Render Service is running. If the computer is not in an area you can monitor easily, you can
use Ctrl+Alt+Delete to lock the computer after logging on and starting the service.

3. Click the Host box of a blank row in the table, and then type the IP address or name of the
computer you want to use as a renderer.

To find your computer name, right-click My Computer and choose Properties from the shortcut
menu to display the System Properties dialog. Click the Computer Name tab, and your computer
name is displayed in the Full computer name entry.

3 sony Vegas Network Render Service EE®
Action
Progress Fienderers | Fis Mappings | Options | Log |
View. |Basic |
Rendererz
Host Shatus
kearney3, drs.net Ready

renderbot, drg.net connecting.,

Hesst: keanney.mynet.net |Por: 53704 | Status: Ready

‘C’\The Status box does not update automatically. If you want to refresh the display, right-click a
renderer and choose Refresh Status from the shortcut menu to update the status of a specific
renderer or all renderers.

4. Press Enter to connect to the renderer. If the connection is made, the Status column will display
Ready.
Removing a renderer

Removing a renderer from the Renderers list removes it from your editing computer. When you
remove a renderer, the service continues to run on the renderer, and any pending rendering jobs
owned by the editing machine are canceled.

1. Start the Vegas Network Render Service application (VegSrv50.exe) on the computer you will use
to initiate network rendering.

If you do not start the service before starting a rendering job, it will start automatically, but it will
not be visible. Right-click the == = icon in the system tray and choose Show from the menu to
display the window.

2. Select the Renderers tab. This tab allows you to edit the list of computers running the render
service.

3. Select a renderer by clicking the leftmost column in the list.
4. Right-click the selected renderer and choose Delete Renderer from the shortcut menu.
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Setting file mappings

Use the File Mappings tab to map local folders on your host machine to universal paths.

File mappings tell remote renderers where to find the media used in your project and where to render
output files.

When you import media from a local disk, the file paths saved in your project are often valid only on
the local machine. This can be the case even if the media resides in a shared folder.

Adding a file mapping

1. Right-click the = icon in your system tray and choose Show from the menu to display the Sony
Vegas Network Render Service window.

Select the File Mappings tab. The tab displays a list of local folders and their universal paths.
Click a blank row in the table.
In the Local box, type the path to the local folder (c:\media, for example).

In the Universal box, type the UNC path or mapped drive letter to the folder (\\kcanney\media\,
for example).

u b wWwN

@ Before you start rendering, verify that the remote renderer has access to the folder and is
logged in.

On the renderer, choose Run from the Start menu to display the Run dialog. In the Open box,
type the UNC path to the folder (\\kcanney\media\ in our previous example). If you're
prompted to log on, type your username and password.

Creating file mappings automatically

1. Right-click the = icon in your system tray and choose Show from the menu to display the Sony
Vegas Network Render Service window.

2. Select the File Mappings tab. The tab displays a list of local folders and their universal paths.

3. Right-click the tab and choose Auto-Fill File Mappings from the shortcut menu. Shared folders on
the local machine are added to the list as universal paths.

@No mappings will be added in the following circumstances:
. If all shared folders are already listed in the table.
. If the computer does not have any shared folders.
. If your user account does not allow you to create or modify folder sharing.

Removing file mappings

1. Right-click the = icon in your system tray and choose Show from the menu to display the Sony
Vegas Network Render Service window.

2. Select the File Mappings tab. The tab displays a list of local folders and their universal paths.

3. Right-click a mapping and choose Delete File Mapping from the shortcut menu to delete it, or click
a blank row in the table and choose Delete All File Mappings to delete all file mappings.
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Running Multiple Instances of the Render Service

If you have a multiprocessor computer or a computer with a processor that supports Hyper-Threading
technology, you can run multiple instances of the render service on a computer.

1. In the Vegas installation folder (typically C:\Program Files\Sony\Vegas5.0\), create a copy of the
NetRenderService.config file.

2. Rename the copy NetRenderServiceX.config. In this example, we’ll name the file
NetRenderService2.config.

3. Open the new .config file in a text editor such as Notepad.

4. Edit the port setting in the config file to use a new value. Each instance of the service must run
on a different port. In the following example, we changed the default setting of 53704 to 53705.

B NetRenderService2.config - Notepad EEE
File Edit Format View Help
<configuration= ~

<sysLem. runtime. remotings
<application=
<SErvicex
<wel1known
mode="5ingleton"

type="Sony.Vegas.NetRender. NetRenderseryvice, Sony. vegas . NetRender"
objectUri="NetRenderservice. rem'"
Fe
<fservices
<channelsx

<channel name="HWetRenderservice" ref="tcp¥ port="537058"
</channel s>

<1ifetime leaseTime="0" [/
</Sapplication=
< /system. runtime. remotings

ul

Save and close the .config file.

6. From the Start menu, choose Run. Type CMD in the Open box and click OK. A DOS window is
displayed.

7. At the command prompt, type cd "c:\program files\Sony\Vegas 5.0\" (you may have to modify
this path if you installed Vegas to a different folder).

8. At the command prompt, type VegSrv50.exe -nosave -config [name of config file] to start the
service using the configuration file you created in steps 1 through 5.

9. Repeat step 8 for each instance of the render service. In the following example, we type

VegSrv50.exe -nosave -config NetRenderService.config and VegSrv50.exe -nosave -config

NetRenderService2.config to start two instances of the service.

INNT Y system32cmd.exe

TS Puright 198522000 NIone20et Corp )
:“Documents and Settings™kevinc.KEUVINC_DUAL>cd "c:“program files“sony“wegas 5.8%"
:“Program Files“Sony“Vegas 5.8*VegSrviB.exe —nosave —-config MetRenderService.config
:“Program Files“Sony“Vegas 5.8*VegSrviB.exe —nosave —-config MetRenderServiceZ.config
:“Program Files“Sony™~Uegas 5.8>

10. Add both instances to the host computer:

a. Start the Vegas Network Render Service application (VegSrv50.exe) on the computer you will
use to initiate network rendering.

If you do not start the service before starting a rendering job, it will start automatically, but it

will not be visible. Right-click the = icon in the system tray and choose Show from the menu
to display the window.

b. Select the Renderers tab. This tab allows you to edit the list of computers running the render
service.

@A computer will be displayed on the Renderers tab only if you have logged on to Windows
and the Vegas Network Render Service is running. If the computer is not in an area you can
monitor easily, you can use Ctrl+Alt+Delete to lock the computer after logging on and
starting the service.

c. From the Vview drop-down list, choose Advanced.

d. Click the Host box of a blank row in the table, and then type the IP address or name of the
computer you want to use as a renderer and the port the service is running.
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In the following example, the service is running on ports 53704 and 53705 on a computer with
IP address 10.0.7.113.

Sony Yegas Network Render Service
Ackion

Progress | Renderers |FiIeMappings Options | Log

Renderers
URL Status
bep:AA10.0.7.113:53704/MetRenderService.rem  Ready

tep:AA10.0.7.113:53705/MetRenderS ervice.rem  Ready
» B -

Host: keanney3. mynet.net |Port: 53704 | Status: Ready

To find your computer name, right-click My Computer and choose Properties from the shortcut
menu to display the System Properties dialog. Click the Computer Name tab, and your
computer name is displayed in the Full computer name entry.

d. Press Enter to connect to the renderer. If the connection is made, the Status column will display
Ready.

10. You're now ready to use both instances of the service for distributed rendering.
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Nondistributed Network Rendering

Nondistributed network rendering behaves very much like standard rendering, but you can choose which
computer you want to render the project. In this mode, each computer renders a complete file from a
Vegas project or the loop region.

If you want to encode the same project to multiple streaming formats and bit rates, it is best to queue
multiple nondistributed jobs because streaming formats use temporal compression and you can assign
different renderers to different output formats.

When you use nondistributed network rendering to batch process a project to several different formats,
intermediate tasks such as compositing only need to be performed once.

If you have a project or output format with audio only, choose nondistributed rendering because only
video is rendered in the first phase of a distributed job.

& Before rendering, ensure all codecs, third-party video effects, and fonts used for generated media in
your project are installed on all computers.

1. If you want to render only a portion of your project, create a time selection that includes the
portion you want to render.

2. From the File menu, choose Render As.

3. Use the Render As dialog to choose the file format and location where you want to save your file.
The location of the output file must be in a shared folder.

4. Select the Render loop region only check box in the Render As dialog if you want to render the
selected portion of your project.

5. Select the Render using networked computers check box in the Render As dialog, and then click
the save button. The Network Render dialog is displayed.

6. From the Render Host drop-down list, choose URL of the renderer you want to use to render your
project.

7. The Temporary Files Location box displays the path to the folder where the temporary .veg
project will be saved. If you want to use a folder other than the output folder you chose in step 3,
you can choose a folder from the drop-down list or click the Browse button to choose a folder.

This folder must be in a shared location.

8. Click OK to start rendering.

Before network rendering begins, a copy of your project will be saved in the shared output folder
(see Step 3) for use by the renderers. This version will have all media paths remapped based on
the Network Render Service file mappings (see “Set file mappings” on page 7 for more
information).

9. To add a project to the queue, open the project and repeat steps 1 through 8.

You can choose a different renderer for each project or time selection if you want to render the
files concurrently on separate computers. If you choose the same renderer, the rendering jobs
will be queued to run sequentially on that computer.
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Distributed Network Rendering

Distributed network rendering splits the video into segments that are rendered by multiple computers. In
this mode, each computer renders a portion of the project, and the rendered sections are then
reassembled into a single file by the one computer (called the stitch host).

Distributed rendering is a good way to reduce the time it takes to render a project containing a significant
amount of processed video (video effects, transitions, panning/cropping, track motion, and compositing).
However, distributed rendering requires increased disk space and network traffic because each segment
must be saved before the final output file can be generated.

Nontemporal video output formats, such as DV or uncompressed AVI, are also well suited for distributed
network rendering because segments can be reassembled without re-encoding. When using temporal
compression, segments are rendered in an uncompressed or nhontemporal format, and temporal
compression is applied during the stitching stage.

& Before rendering, ensure all codecs, third-party video effects, and fonts used for generated media in
your project are installed on all computers.

1. From the File menu, choose Render As.

2. Use the Render As dialog to choose the file format and location where you want to save your file.
The location of the output file must be in a shared folder.

3. Select the Render using networked computers check box in the Render As dialog, and then click
the save button. The Network Render dialog is displayed.

4. Select the Distribute Rendering check box in the Network Render dialog.

5. From the Stitch Host drop-down list, choose the computer you want to use to assemble the
rendered segments.

6. Select the Use Final Render Template check box if you want to render segments using the format
you chose for your final output in the Render As dialog.

Use this option when you're working with uncompressed or DV files. In this case, using the final
rendering template for rendered segments makes the final stitching process fast because the
segments can be copied and assembled without being re-encoded. You'll also conserve disk space
and reduce network traffic.

@ Note that using lossy compression for your rendered segments will produce lower-quality
video than using an uncompressed or YUV template because the stitching process will need to
re-encode the final stream from the compressed segments.

You can render segments as MPEG-2 only in the following cases:
+» If you're running multiple instances of the render service on your editing computer and no
other instances of the render service are running with the same serial number.
+ Vegas software is installed with a unique serial number on each computer (editing
computer and renderers).
* Vegas software is installed with a site license serial humber on each computer.
7. Clear the Use Final Render Template check box and choose settings from the Save as Type and
Template drop-down lists if you want to render segments using a format other than your final
output format. Use the Render As dialog if you need to create custom templates.

Use this option when you're rendering to a format that uses temporal compression, such as
MPEG, QuickTime, RealMedia, or Windows Media. Rendering segments as uncompressed or DV
AVI files allows transitions and composited tracks to be rendered in a high-quality format. When
the segments are stitched, the project is re-encoded using the format you chose for your final
output in the Render As dialog.

@ If you create custom rendering templates for rendering segments, clearing the Include Audio
check box for the template will help conserve disk space.
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8. The Temporary Files Location box displays the path to the folder where the temporary .veg
project and rendered segments will be saved. If you want to use a folder other than the output
folder you chose in step 2, you can choose a folder from the drop-down list or click the Browse
button to choose a folder.

This folder must be in a shared location.

@ Choosing a folder other than the final output folder can help improve performance during the
stitching phase when you render a project with uncompressed segments.

9. Click OK to start rendering.

Before network rendering begins, a copy of your project will be saved in the shared output folder
(see Step 2) for use by the renderers. This version will have all media paths remapped based on
the Network Render Service file mappings (see “Set file mappings” on page 7 for more
information).

Monitoring Rendering Progress

Use the Progress tab in the Sony Vegas Network Render Service window to monitor the status of your
rendering jobs.

1. Right-click the = icon in your system tray and choose Show from the menu to display the Sony

Vegas Network Render Service window.
2. Select the Progress tab. The Progress tab displays a list of the segments that are queued to
render, the assigned renderer, and the status.

3. Choose Details or Summary from the View drop-down list in the Progress tab to see more or less
information.

In Details view, you can click the + button to expand a list of links to more detailed information
about your rendering jobs. Click a link to display information about job status, rendered segment
status, job summary information, or error messages.

RenderJob Detais

Owrier Port < | Job #| Project File | Dutput File
b | 53704 2 H:\Canney  H:ACanney'\MetRender

=

obSeqments
JobSummary
JobErmors

Right-click a job and choose cancel Job from the shortcut menu to stop rendering.
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Network Rendering Options

Use the Options tab in the Sony Vegas Network Render Service window to set user options for the service.

el
1. Right-click the = icon in your system tray and choose Show from the menu to display the Sony
Vegas Network Render Service window.

2. Select the Options tab.

Item Description

Enable rendering Select this check box if you want the local computer to be
available as a renderer.

Automatically run after login Select this check box if you want to start the service
automatically after logging in to the Windows operating
system.

Hide window when minimized Select this check box if you want to hide the Sony Vegas

Network Render Service window when minimized. You can
right-click the icon in the system tray and choose Show to
make the window visible again.

When the check box is cleared, the Sony Vegas Network
Render Service window minimizes like a normal window, and
you can switch to it by pressing Alt+Tab or by clicking its icon
in the status bar.

Exit service when window is closed Select this check box if you want to keep the service running
after closing the window. If the check box is cleared, the
service is minimized to the system tray when you close the
window.

Exit Vegas when idle Select this check box if you want to close the instance of
Vegas software that is launched by the network render service
when no jobs are in the queue.

If the check box is cleared, the application continues running
until you close it or exit the service.

Remove completed jobs from progress Choose a setting to indicate how long jobs should be

display after maintained on the Progress tab of the Sony Vegas Network
Render Service window.

Default segment length Choose a setting to indicate the number of frames per

segment when using distributed rendering.

Adjusting this value can increase performance slightly
depending on the complexity of the project and the speed of
your rendering computers.

If the setting yields more than 90 segments for a rendering
job, the segment length for that job is automatically increased
to limit the number of segments.

If this setting yields only one segment for a rendering job, the
job will be executed as a nondistributed job on the stitch host.
For example, if you render a one-second project with the
Default Segment Length set to 30 frames, only one
segment can be created. Decrease the segment length if you
want to use distributed rendering with short projects.
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